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Fully Integrated, Hall Effect-Based Linear Current Sensor 

with 2.1 kVRMS Voltage Isolation and a Low-Resistance Current Conductor 
 

 

Features and Benefits 
▪ Low-noise analog signal path 

▪ Device bandwidth is set via the new FILTER pin 

▪ 5 μs output rise time in response to step input current 

▪ 80 kHz bandwidth 

▪ Total output error 1.5% at TA= 25°C 
▪ Small footprint, low-profile SOIC8 package 
▪ 1.2 mΩ internal conductor resistance 

▪ 2.1 kVRMS minimum isolation voltage from pins 1-4 to pins 5-8 
▪ 5.0 V, single supply operation 
▪ 66 to 185 mV/A output sensitivity 

▪ Output voltage proportional to AC or DC currents 

▪ Factory-trimmed for accuracy 

▪ Extremely stable output offset voltage 

▪ Nearly zero magnetic hysteresis 

▪ Ratiometric output from supply voltage 

TÜV America 
Certificate Number: 

U8V 06 05 54214 010 

 
 
 
 

Package: 8 Lead SOIC (suffix LC) 

Description 
The Allegro® ACS712 provides economical and precise 

solutions for AC or DC current sensing in industrial, 

commercial, and communications systems. The device 

package allows for easy implementation by the customer. 

Typical applications include motor control, load detection and 

management, switched-mode power supplies, and overcurrent 

fault protection. 

The device consists of a precise, low-offset, linear Hall 

sensor circuit with a copper conduction path located near the 

surface of the die. Applied current flowing through this copper 

conduction path generates a magnetic field which is sensed 

by the integrated Hall IC and converted into a proportional 

voltage. Device accuracy is optimized through the close 

proximity of the magnetic signal to the Hall transducer. A 

precise, proportional voltage is provided by the low-offset, 

chopper-stabilized BiCMOS Hall IC, which is programmed 

for accuracy after packaging. 

The output of the device has a positive slope (>VIOUT(Q)) 

when an increasing current flows through the primary copper 

conduction path (from pins 1 and 2, to pins 3 and 4), which 

is the path used for current sensing. The internal resistance of 

this conductive path is 1.2 mΩ typical, providing low power 
 

Continued on the next page… 

 

 
Approximate Scale 1:1 

 

 

Typical Application 
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Application 1. The ACS712 outputs an analog signal, VOUT . 

that varies linearly with the uni- or bi-directional AC or DC 
primary sensed current, IP , within the range specified. CF 

is recommended for noise management, with values that 

depend on the application. 
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Fully Integrated, Hall Effect-Based Linear Current Sensor with 

2.1 kVRMS Voltage Isolation and a Low-Resistance Current Conductor 
 

 

 

Description (continued) 
loss. The thickness of the copper conductor allows survival of 

the device at up to 5× overcurrent conditions. The terminals of 

the conductive path are electrically isolated from the sensor leads 

(pins 5 through 8). This allows the ACS712 current sensor to be 

used in applications requiring electrical isolation without the use 

of opto-isolators or other costly isolation techniques. 

 
The ACS712 is provided in a small, surface mount SOIC8 package. 

The leadframe is plated with 100% matte tin, which is compatible 

with standard lead (Pb) free printed circuit board assembly processes. 

Internally, the device is Pb-free, except for flip-chip high-temperature 

Pb-based solder balls, currently exempt from RoHS. The device is 

fully calibrated prior to shipment from the factory. 

 
 

Selection Guide 

Part Number Packing* 
TA 

(°C) 
Optimized Range, IP 

(A) 
Sensitivity, Sens 

(Typ) (mV/A) 

ACS712ELCTR-05B-T Tape and reel, 3000 pieces/reel –40 to 85 ±5 185 

ACS712ELCTR-20A-T Tape and reel, 3000 pieces/reel –40 to 85 ±20 100 

ACS712ELCTR-30A-T Tape and reel, 3000 pieces/reel –40 to 85 ±30 66 

*Contact Allegro for additional packing options. 

Absolute Maximum Ratings 

Characteristic Symbol Notes Rating Units 

Supply Voltage VCC  8 V 

Reverse Supply Voltage VRCC  –0.1 V 

Output Voltage VIOUT  8 V 

Reverse Output Voltage VRIOUT  –0.1 V 

 
Reinforced Isolation Voltage 

 
VISO 

Pins 1-4 and 5-8; 60 Hz, 1 minute, TA=25°C 2100 V 

Voltage applied to leadframe (Ip+ pins), based 

on IEC 60950 
184 Vpeak 

 
Basic Isolation Voltage 

 
VISO(bsc) 

Pins 1-4 and 5-8; 60 Hz, 1 minute, TA=25°C 1500 V 

Voltage applied to leadframe (Ip+ pins), based 

on IEC 60950 
354 Vpeak 

Output Current Source IIOUT(Source)  3 mA 

Output Current Sink IIOUT(Sink)  10 mA 

Overcurrent Transient Tolerance IP 1 pulse, 100 ms 100 A 

Nominal Operating Ambient Temperature TA Range E –40 to 85 ºC 

Maximum Junction Temperature TJ(max)  165 ºC 

Storage Temperature Tstg  –65 to 170 ºC 

 
 
 
 

Parameter Specification 

 
Fire and Electric Shock 

CAN/CSA-C22.2 No. 60950-1-03 

UL 60950-1:2003 

EN 60950-1:2001 
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ACS712 
Fully Integrated, Hall Effect-Based Linear Current Sensor with 

2.1 kVRMS Voltage Isolation and a Low-Resistance Current Conductor 

Functional Block Diagram 
 
 
 

 
 
 
 
 
 
 
 

IP+ 
(Pin 1) 

IP+ 
(Pin 2) 

 
 
 

IP 
(Pin 3) 

IP 
(Pin 4) 

 
 
 
 
 
 
 
 

 
Pin-out Diagram 

 
    

IP+ 1   8 VCC 

IP+ 2   7 VIOUT 
      

IP– 3   6 FILTER 
      

IP– 4   5 GND 
      

Terminal List Table 

Number Name Description 

1 and 2 IP+ Terminals for current being sensed; fused internally 

3 and 4 IP– Terminals for current being sensed; fused internally 

5 GND Signal ground terminal 

6 FILTER Terminal for external capacitor that sets bandwidth 

7 VIOUT Analog output signal 

8 VCC Device power supply terminal 
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Fully Integrated, Hall Effect-Based Linear Current Sensor with 

2.1 kVRMS Voltage Isolation and a Low-Resistance Current Conductor 
 

 

 

 

 

 

 

 
 

COMMON OPERATING CHARACTERISTICS1 over full range of TA, CF = 1 nF, and VCC = 5 V, unless otherwise specified 

Characteristic Symbol Test Conditions Min. Typ. Max. Units 

ELECTRICAL CHARACTERISTICS 

Supply Voltage VCC  4.5 5.0 5.5 V 

Supply Current ICC VCC = 5.0 V, output open – 10 13 mA 

Output Capacitance Load CLOAD VIOUT to GND – – 10 nF 

Output Resistive Load RLOAD VIOUT to GND 4.7 – – kΩ 

Primary Conductor Resistance RPRIMARY TA = 25°C – 1.2 – mΩ 

Rise Time tr IP = IP(max), TA = 25°C, COUT = open – 5 – μs 

Frequency Bandwidth f –3 dB, TA = 25°C; IP is 10 A peak-to-peak – 80 – kHz 

Nonlinearity ELIN Over full range of IP – 1.5 – % 

Symmetry ESYM Over full range of IP 98 100 102 % 

Zero Current Output Voltage VIOUT(Q) Bidirectional; IP = 0 A, TA = 25°C – 
VCC × 

0.5 
– V 

Power-On Time tPO 
Output reaches 90% of steady-state level, TJ = 25°C, 20 A present 
on leadframe 

– 35 – μs 

Magnetic Coupling2   – 12 – G/A 

Internal Filter Resistance3 RF(INT)   1.7  kΩ 

1Device may be operated at higher primary current levels, IP, and ambient, TA , and internal leadframe temperatures, TA, provided that the Maximum 
Junction Temperature, TJ(max), is not exceeded. 
21G = 0.1 mT. 
3RF(INT) forms an RC circuit via the FILTER pin. 

 
 
 
 
 
 
 

 
COMMON THERMAL CHARACTERISTICS1 

 Min. Typ. Max. Units 

Operating Internal Leadframe Temperature TA E range –40 – 85 °C 

 Value Units 

Junction-to-Lead Thermal Resistance2 RθJL Mounted on the Allegro ASEK 712 evaluation board 5 °C/W 

Junction-to-Ambient Thermal Resistance RθJA 
Mounted on the Allegro 85-0322 evaluation board, includes the power con- 

sumed by the board 
23 °C/W 

1Additional thermal information is available on the Allegro website. 

2The Allegro evaluation board has 1500 mm2 of 2 oz. copper on each side, connected to pins 1 and 2, and to pins 3 and 4, with thermal vias connect- 

ing the layers. Performance values include the power consumed by the PCB. Further details on the board are available from the Frequently Asked 

Questions document on our website. Further information about board design and thermal performance also can be found in the Applications Informa- 

tion section of this datasheet. 
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x05B PERFORMANCE CHARACTERISTICS TA = –40°C to 85°C1, CF = 1 nF, and VCC = 5 V, unless otherwise specified 

Characteristic Symbol Test Conditions Min. Typ. Max. Units 

Optimized Accuracy Range IP  –5 – 5 A 

Sensitivity Sens Over full range of IP, TA = 25°C 180 185 190 mV/A 

Noise VNOISE(PP) 
Peak-to-peak, TA = 25°C, 185 mV/A programmed Sensitivity, 

CF = 47 nF, COUT = open, 2 kHz bandwidth 
– 21 – mV 

Zero Current Output Slope ∆IOUT(Q) 
TA = –40°C to 25°C – –0.26 – mV/°C 

TA = 25°C to 150°C – –0.08 – mV/°C 

Sensitivity Slope ∆Sens 
TA = –40°C to 25°C – 0.054 – mV/A/°C 

TA = 25°C to 150°C – –0.008 – mV/A/°C 

Total Output Error2 ETOT IP =±5 A, TA = 25°C – ±1.5 – % 

1Device may be operated at higher primary current levels, IP, and ambient temperatures, TA, provided that the Maximum Junction Temperature, TJ(max), 
is not exceeded. 

2Percentage of IP, with IP = 5 A. Output filtered. 

 
 

x20A PERFORMANCE CHARACTERISTICS TA = –40°C to 85°C1, CF = 1 nF, and VCC = 5 V, unless otherwise specified 

Characteristic Symbol Test Conditions Min. Typ. Max. Units 

Optimized Accuracy Range IP  –20 – 20 A 

Sensitivity Sens Over full range of IP, TA = 25°C 96 100 104 mV/A 

Noise VNOISE(PP) 
Peak-to-peak, TA = 25°C, 100 mV/A programmed Sensitivity, 

CF = 47 nF, COUT = open, 2 kHz bandwidth 
– 11 – mV 

Zero Current Output Slope ∆IOUT(Q) 
TA = –40°C to 25°C – –0.34 – mV/°C 

TA = 25°C to 150°C – –0.07 – mV/°C 

Sensitivity Slope ∆Sens 
TA = –40°C to 25°C – 0.017 – mV/A/°C 

TA = 25°C to 150°C – –0.004 – mV/A/°C 

Total Output Error2 ETOT IP =±20 A, TA = 25°C – ±1.5 – % 

1Device may be operated at higher primary current levels, IP, and ambient temperatures, TA, provided that the Maximum Junction Temperature, 

TJ(max), is not exceeded. 
2Percentage of IP, with IP = 20 A. Output filtered. 

 
 

x30A PERFORMANCE CHARACTERISTICS TA = –40°C to 85°C1, CF = 1 nF, and VCC = 5 V, unless otherwise specified 

Characteristic Symbol Test Conditions Min. Typ. Max. Units 

Optimized Accuracy Range IP  –30 – 30 A 

Sensitivity Sens Over full range of IP , TA = 25°C 64 66 68 mV/A 

Noise VNOISE(PP) 
Peak-to-peak, TA = 25°C, 66 mV/A programmed Sensitivity, 

CF = 47 nF, COUT = open, 2 kHz bandwidth 
– 7 – mV 

Zero Current Output Slope ∆IOUT(Q) 
TA = –40°C to 25°C – –0.35 – mV/°C 

TA = 25°C to 150°C – –0.08 – mV/°C 

Sensitivity Slope ∆Sens 
TA = –40°C to 25°C – 0.007 – mV/A/°C 

TA = 25°C to 150°C – –0.002 – mV/A/°C 

Total Output Error2 ETOT IP = ±30 A, TA = 25°C – ±1.5 – % 

1Device may be operated at higher primary current levels, IP, and ambient temperatures, TA, provided that the Maximum Junction Temperature, 

TJ(max), is not exceeded. 
2Percentage of IP, with IP = 30 A. Output filtered. 
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ACS712 
Fully Integrated, Hall Effect-Based Linear Current Sensor with 

2.1 kVRMS Voltage Isolation and a Low-Resistance Current Conductor 

Characteristic Performance 
IP = 5 A, unless otherwise specified 
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770 series Ø45 mm 21-114 W 
 

 
- - 

 

Cabron brush = C 

Metal brush = M 

V = Varistor 

C = Capacitor 

 

MOTOR DATA 

Part name 770-4087-CC 770-7040-CC 770-8525F-CC 770-32165-CC 

Diameter (mm) 45 45 45 45 

Lenth (mm) 66 66 66 66 

Nominal voltage (V) 12 12 12 24 

Nominal speed (rpm) 3500 8400 13500 3900 

Nominal torque (mNm) 56.1 59.3 80.3 52.9 

Nominal current A 2.8 6.0 12.1 1.3 

No load speed (rpm) 4550 9700 16000 4650 

No load current A 0.60 1.30 1.80 0.22 

Stall torque (mNm) 334.1 595.7 587.9 397.1 

Starting current (A) 14.1 56.9 83.0 8.6 

Output (W) 21 53 114 22 

Efficiency (%) 63 73 79 74 

Operating temperature deg. C -10..+60 -10..+60 -10..+60 -10..+60 

 

775 series Ø45 mm 103-198 W 
 

 

- - 
 

Cabron brush = C 

Metal brush = M 

V = Varistor 

C = Capacitor 

 
MOTOR DATA 

Part name 775-9008F-CC 775-9009F-C-CC 775-8013F-C-CC 775-5520F-CC 

Diameter (mm) 45 45 45 45 

Lenth (mm) 66 66 66 66 

Nominal voltage (V) 7.2 12 18 24 

Nominal speed (rpm) 12300 18000 18700 18400 

Nominal torque (mNm) 80.0 102.6 100.8 94.3 

Nominal current A 20.1 21.1 15.8 10.7 

No load speed (rpm) 14600 21000 22000 21000 

No load current A 3.20 2.80 3.00 1.70 

Stall torque (mNm) 508.8 806.4 837.3 705.9 

Starting current (A) 108.7 143.7 110.4 68.1 

Output (W) 103 194 198 182 

Efficiency (%) 72 77 70 71 

Operating temperature deg. C -10..+60 -10..+60 -10..+60 -10..+60 
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 Electrical Charateristics 
 

 Attractive cycle life

 Extended safety performance

 Wide operating temperature range

 Unrivalled high temperature performance

 Green energy without metal contaminant

 High capacity

 Steady output voltage

 Little self-discharge

 Double safety protection

 Withstanding very high level of vibrations 

and shocks
 

 
 

 Over-charge/Over-discharge Ability to 

withstand over-charge/withstand

over-discharge, and there is no fire, no 

exploding and work well 

 Short circuit Ability to withstand short 

circuit, and there is no fire, no exploding

 Acupuncture Ability to withstand nail 

puncturing, and there is no fire, no 

exploding

 Thermal shock Ability to withstand thermal 

shock, and there is no fire, no exploding

 
 
 
 
 
 
 

 Mechanical Characteristics
 

Diameter 32.2±0.5mm 

Height 70.0±0.2mm 

Weight ~145g 

 Operation Conditions
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LiFePO4 Battery 32650-5Ah 

Cylindrical Lithium Iron Phosphate Battery 

 
OPT-32650F 

OptimumNano always develop and produce 

32650 cells to or assemble battery packs to 

satisfy the requirements of high performance 

and operational reliability of our customers. We 

also have the 14500/18650/22650/26650 cells 

to meet all your requirements. 

Brief Introduction 

Safety Characteristics 

Key Features 

Nominal Voltage 3.2V 

Nominal Capacity 

(at 0.5C, 25 degC) 

 

6Ah 

Impedance 

(Max. at1000Hz) 

 

≤10mΩ 

 

Expected Cycle Life 
More than 2000 cycles, with 1C 

charge and discharge rate, at 25 ℃ 

 

Charge Method CC-CV 

Max. Charge Voltage 3.65V 

Continuous Charge Current 0.2C 

Charge Temperature 0℃～45℃ 

Continuous Discharge 

Current 

 

1C 

Max. Discharge Current 2C 

Peak Instant Discharge 

Current(10 Seconds) 

 

3C 

Discharge Cut-off Voltage 2.5V 

Discharge Temperature -20℃～65℃ 

Storage Temperature -20℃～40℃ 

Self Discharge 

(Stored at 50% SOC) 

 

<= 3%/month 
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Typical Performance Curve 
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Warnings and Tips 

 

 
1. Based on the character of cell, proper environment for 

transportation of LiFePO4 battery pack need to be created 

to protect the battery. 

2. During transportation, 50% SOC must be kept to ensure 

that short circuit, appearance of liquid in the battery or 

immersion of battery in liquid never occur. 

3. Battery should be kept at -20℃～45℃ in warehouse 

where it’s dry, clean and well-ventilated. 

4. During loading of battery, attention must be paid against 

dropping, turning over and serious stacking. 

 

In order to prevent the battery leaking, getting hot and exploding, please pay attention to preventing measure as 

following: 

Warning! 

 Never throw the battery into water, keep it under dry, 

shady and cool circumstance when not use. 

 Never upside down the positive and negative. 

 Never connect the positive and negative of battery with 

metal. 

 Never ship or store the battery together with metal 

 Never knock, throw or trample the battery. 

 Never cut through the battery with nail or other edge tool. 

 

Tips! 

 Never use or keep the battery under the high temperature. 

Otherwise it will cause battery heat, get into fire or lose 

some function and reduce the life. The proposed 

temperature for long-term storage is 10-45℃. 

 Never throw the battery into fire or heating machine to 

avoid fire, explosion and environment pollution; scrap 

battery should be returned to the supplier and handled by 

the recycle station. 

 Never use the battery under strong static and strong 

magnetic field, otherwise it will destroy the protecting 

device. 

 If battery leaked, the electrolyte get into eyes, please don’t 

knead, please wash eyes by water and send to hospital. 

Otherwise it will hurt eyes. 

 If battery emit peculiar smell, heating, distortion or appear 

any unconventionality during using, storage or charging 

process, please take it out from device or charge and stop 

using. 

 Never cut the battery in socket directly; please use the 

stated charger when charging. 

 Check the voltage of battery and relevant connectors 

before using the battery. It can’t be used until everything 

turns out to be normal. 

 Prior to charging, fully check the insulativity, physical 

condition and ageing status, since breakage and ageing 

are never allowed; the pack voltage must not be less than 

the cutoff voltage, if not, it’s abnormal and that battery 

needs to be labeled. The user should contact our 

Customer Service Dept and it can’t be charged until 

repaired by our staff. 

 The battery should be stored in 50% SOC. It needs to be 

charged once if out of use for as long as half a year. 

 Clean the dirty electrode, if any, with a clean dry cloth, or 

poor contact or operation failure may occur. 
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Overview  
 

The INA219B breakout board will solve all your power-monitoring problems. Instead of struggling with two multimeters, 

you can use this breakout to measure both the high side voltage and DC current draw over I2C with 1% precision. 

 

 

 

Why the High Side? 
Most current-measuring devices such as our current panel meter are only good for low side measuring. That means 

that unless you want to get a battery involved, you have to stick the measurement resistor between the target ground 

and true ground. 

 

Since the voltage drop across the resistor is proportional to the current draw, this means that the ground reference will 

change with varying current. Having a shifting ground reference can cause problems for many circuits. 

 

The INA219B chip is much smarter - it can handle high side current measuring, up to +26VDC, even though it is 

powered with 3 or 5V. It will also report back that high side voltage, which is great for tracking battery life or solar 

panels. 

 

How does it work? 
A precision amplifier measures the voltage across the 0.1 ohm, 1% sense resistor. Since the amplifier maximum input 

difference is ±320mV this means it can measure up to ±3.2 Amps. With the internal 12 bit ADC, the resolution at ±3.2A 

range is 0.8mA. With the internal gain set at the minimum of div8, the max current is ±400mA and the resolution is 

0.1mA. Advanced hackers can remove the 0.1 ohm current sense resistor and replace it with their own to change the 

range (say a 0.01 ohm to measure up 32 Amps with a resolution of 8mA) 
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Assembly 

 

 
 

 

 

The board comes with all surface-mount components 

pre-soldered. Additional parts are included to help 

integrate the INA219 breakout board into your project. 

 

 

 

 

 

 

 

 

 

Wires can be soldered directly to the holes on the edge 

of the board. But for breadboard use, you will want to 

solder on the included 6-pin header. 

 

 

 

 

 

 

 
The load can be connected via the header, or using the 

included 2-pin screw-terminal. 

 

 

 

 

 

 

 

 

 

 
 

 

Addressing the Boards 
If more than one INA219 breakout board is used, each board must be assigned a unique address. This is done with the 

address jumpers on the right edge of the board. The I2C base address for each board is 0x40. The binary address 

that you program with the address jumpers is added to the base I2C address. 
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To program the address offset, use a drop of solder to bridge the corresponding address jumper for each binary '1' in 

the address. 
 

Up to 4 boards may be connected. Addressing is as follows: 

Board 0: Address = 0x40 Offset = binary 00000 (no jumpers required) 

Board 1: Address = 0x41 Offset = binary 00001 (bridge A0 as in the photo above) 

Board 2: Address = 0x44 Offset = binary 00100 (bridge A1) 

Board 3: Address = 0x45 Offset = binary 00101 (bridge A0 & A1) 
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The INA219 breakout board can be powered by the 5v pin on your Arduino and communicates via I2C. 

 

 

Connect to the microprocessor 

Connect GND to GND 

Connect VCC to 5v 

Then connect SDA to SDA (Analog pin 4 on pre-R3 Arduinos) 

And connect SCL to SCL (Analog pin 5 on pre-R3 Arduinos) 

 

On R3 and later Arduinos, you can connect to the new dedicated SDA & SCL pins next to the AREF pin. On pre-R3 

Megas, SDA & SCL are on pins 20 & 21. 
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Wiring 



 

 
 

 

Next we must insert the INA219 current sensor into the circuit we want to measure: 
 

 

Connect to the circuit 

Connect V+ to the positive terminal of the power supply for the circuit under test. 
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Connect V- to the positive terminal or lead of the load. This puts the sense resistor in-line with the circuit. 

Finally, connect a wire from the negative terminal of the power supply to GND. This allows the sensor to 

measure the load voltage as well as the load current. 

The photo below shows an INA219 breakout board configured to measure the motor supply current on an Adafruit 

Motor Shield. 
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Programming the Adafruit INA219 breakout board is simple using our library: 

 

Install the Library 

Download the library from the Downloads button below 

 

  Download Adafruit_INA219  

https://adafru.it/rMD 

 

Expand the .zip file to the Libraries folder in your Arduino Sketchbook folder (If you don't know where this is, 

open File->Preferences in the IDE and it will tell you the location of your sketchbook folder). 

Rename the folder to Adafruit_INA219 

Close all instances of the IDE, then re-open one, so that the IDE will recognize the new library. 

 

Load the Example 

Select "File->Examples->Adafruit_INA219->getcurrent" 

The "getcurrent" example code should open in a new IDE window. 
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Arduino Code 

https://github.com/adafruit/Adafruit_INA219
https://github.com/adafruit/Adafruit_INA219
https://github.com/adafruit/Adafruit_INA219/archive/master.zip


Run it! 

Click on the upload button in the IDE. When it is "done uploading" 

Open your Serial Monitor and set the speed to 115200 baud. 

The output should appear similar to the sample below: 
 

 

Customize it 
You can adapt, expand or modify the example code to suit your project requirements. For a detailed description of the 

available library functions, see the Library Reference on the next page: 
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Library Reference 

Construction and Initialization Functions: 
 

Adafruit_INA219(uint8_t addr = INA219_ADDRESS); 

 

Constructs an instance of the Adafruit_INA219.  If no address is specified, the default address (0x40) is used.  If more 

than one INA219 module is connected, it should be addressed as shown on the Assembly page and the configured 

address passed to the constuctor. 

 

void begin(void); 

 

Initializes I2C communication with the Adafruit_INA219 device using the default configuration values. 

Example: 

 

Sensor Reading Functions: 
 

float getBusVoltage_V(void); 

 

Reads the voltage between GND and V-. This is the total voltage seen by the circuit under test. (Supply voltage - 

shunt voltage). 

 

The return value is in Volts. 

 

float getShuntVoltage_mV(void); 

 

Reads the voltage between V- and V+. This is the measured voltage drop across the shunt resistor. 

The return value is in Milivolts. 

float getCurrent_mA(void); 

 

Reads the current, derived via Ohms Law from the measured shunt voltage. 

The return value is in Milliamps. 

Example: 
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Eagle PCB files for the INA219 breakout board 

Arduino driver library 

Data Sheet for the INA219 chip 

Fritzing object in the Adafruit Fritzing library 

Schematic & Fabrication Print  
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Downloads 

  

https://github.com/adafruit/Adafruit-INA219-Current-Sensor-PCB
https://github.com/adafruit/Adafruit_INA219
http://www.adafruit.com/datasheets/ina219.pdf
https://github.com/adafruit/Fritzing-Library


Arduino 25V Voltage Sensor Module 

 
The Basics 

The Arduino analog input is limited to a 5 VDC input. If you wish to measure higher voltages, you will need to resort to 

another means. One way is to use a voltage divider. The one discussed here is found all over Amazon and eBay. 

 
It is fundamentally a 5:1 voltage divider using a 30K and a 7.5K Ohm resistor.  

 
Keep in mind, you are restricted to voltages that are less than 25 volts. More than that and you will exceed the voltage 

limit of your Arduino input. 

 

 

Basic Connection 
 

Inputs 
 GND – This is where you connect the low side of the voltage you are measuring. Caution! : This is the same 

electrical point as your Arduino ground.

 VCC: The is where you connect the high side of the voltage you are measuring

 

Outputs 
 S: This connects to your Arduino analog input.

 – (or minus): This connects to your Arduino ground.

 +: This is not connected. It does absolutely nothing… zilch… nada… jack diddly doo doo. 

 

Schematic 

The schematic for this is pretty straight forward. As previously mentioned, its just a couple of resistors. In fact, you 

could build your own in a pinch. 

 



Tutorial 

The Connections 

Find yourself a 9 volt battery and connect it, your voltage sensor module and Arduino as shown below.  

 

 

 

 
 

The Sketch 

Enter the following sketch, upload it and go to town. If you open your Arduino serial monitor you 

will be able to see the voltage. 

 
/* 

DC Voltmeter Using a Voltage Divider 

Based on Code Created By 

T.K.Hareendran 

*/ 

 

int analogInput = A1; 

float vout = 0.0; 

float vin =  0.0; 

float R1 = 30000.0; // 

float R2 = 7500.0; // 

int value = 0; 

void setup(){ 

pinMode(analogInput, INPUT); 

Serial.begin(9600); 

Serial.print("DC VOLTMETER"); 

} 

void loop(){ 

// read the value at analog input 

value = analogRead(analogInput); 

vout = (value * 5.0) / 1024.0; // see text 

vin = vout / (R2/(R1+R2)); 

 

Serial.print("INPUT V= "); 

Serial.println(vin,2); 

delay(500); 

} 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The Arduino Nano is a small, complete, and breadboard-friendly board based on the 
ATmega328 (Arduino Nano 3.0) or ATmega168 (Arduino Nano 2.x). It has more or less  
the same functionality of the Arduino Duemilanove, but in a different package. It lacks only 
a DC power jack, and works with a Mini-B USB cable instead of a standard one. The Nano 
was designed and is being produced by Gravitech. 

 
 
 
 

 

 

 

 
 
 



 

 

Arduino Nano 3.0 (ATmega328): schematic, Eagle files. 

 
Arduino Nano 2.3 (ATmega168): manual (pdf), Eagle files. Note: since the free version of 
Eagle does not handle more than 2 layers, and this version of the Nano is 4 layers, it is 
published here unrouted, so users can open and use it in the free version of Eagle. 

 

 
Microcontroller Atmel ATmega168 or ATmega328 

Operating Voltage (logic 
level) 

5 V 

Input Voltage 
(recommended) 

7-12 V 

Input Voltage (limits) 6-20 V 

Digital I/O Pins 14 (of which 6 provide PWM output) 

Analog Input Pins 8 

DC Current per I/O Pin 40 mA 

Flash Memory 
16 KB (ATmega168) or 32 KB (ATmega328) of which 2 KB used by 
bootloader 

SRAM 1 KB (ATmega168) or 2 KB (ATmega328) 

EEPROM 512 bytes (ATmega168) or 1 KB (ATmega328) 

Clock Speed 16 MHz 

Dimensions 0.73" x 1.70" 

 

 

 

http://arduino.cc/en/uploads/Main/ArduinoNano30Schematic.pdf
http://arduino.cc/en/uploads/Main/ArduinoNano30Eagle.zip
http://arduino.cc/en/uploads/Main/ArduinoNanoManual23.pdf
http://gravitech.us/Arduino/Arduino_Nano_V2_3_Eagle.zip


 

 
 

The Arduino Nano can be powered via the Mini-B USB connection, 6-20V unregulated external power supply 
(pin 30), or 5V regulated external power supply (pin 27). The power source is automatically selected to the 
highest voltage source. 

 
The FTDI FT232RL chip on the Nano is only powered if the board is being powered over USB. As a result, 
when running on external (non-USB) power, the 3.3V output (which is supplied by the FTDI chip) is not 
available and the RX and TX LEDs will flicker if digital pins 0 or 1 are high. 

 

 
The ATmega168 has 16 KB of flash memory for storing code (of which 2 KB is used for the bootloader); the 
ATmega328 has 32 KB, (also with 2 KB used for the bootloader). The ATmega168 has 1 KB of SRAM and 
512 bytes of EEPROM (which can be read and written with the EEPROM library); the ATmega328 has 2 KB 
of SRAM and 1 KB of EEPROM. 

 

 
Each of the 14 digital pins on the Nano can be used as an input or output, using pinMode(), digitalWrite(), 
and digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA 
and has an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have 
specialized functions: 

 
 Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. These pins are 

connected to the corresponding pins of the FTDI USB-to-TTL Serial chip.

 External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a 

rising or falling edge, or a change in value. See the attachInterrupt() function for details.

 PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.

 SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which, 

although provided by the underlying hardware, is not currently included in the Arduino language.

 LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is 

on, when the pin is LOW, it's off.

 
The Nano has 8 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By 
default they measure from ground to 5 volts, though is it possible to change the upper end of their range 
using the analogReference() function. Additionally, some pins have specialized functionality: 

 
 I

2
C: 4 (SDA) and 5 (SCL). Support I

2
C (TWI) communication using the Wire library (documentation 

on the Wiring website).

 
There are a couple of other pins on the board: 

 
 AREF. Reference voltage for the analog inputs. Used with analogReference().

 Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to 

shields which block the one on the board.

 
See also the mapping between Arduino pins and ATmega168 ports. 

 
 
 
 
 
 

 

http://www.arduino.cc/en/Reference/EEPROM
http://arduino.cc/en/Reference/PinMode
http://arduino.cc/en/Reference/DigitalWrite
http://arduino.cc/en/Reference/DigitalRead
http://arduino.cc/en/Reference/AttachInterrupt
http://arduino.cc/en/Reference/AnalogWrite
http://arduino.cc/en/Reference/AnalogReference
http://wiring.org.co/reference/libraries/Wire/index.html
http://arduino.cc/en/Reference/AnalogReference
http://arduino.cc/en/Hacking/PinMapping168


 
 

The Arduino Nano has a number of facilities for communicating with a computer, another Arduino, or other 
microcontrollers. The ATmega168 and ATmega328 provide UART TTL (5V) serial communication, which is 
available on digital pins 0 (RX) and 1 (TX). An FTDI FT232RL on the board channels this serial 
communication over USB and the FTDI drivers (included with the Arduino software) provide a virtual com 
port to software on the computer. The Arduino software includes a serial monitor which allows simple textual 
data to be sent to and from the Arduino board. The RX and TX LEDs on the board will flash when data is 
being transmitted via the FTDI chip and USB connection to the computer (but not for serial communication 
on pins 0 and 1). 

 
A SoftwareSerial library allows for serial communication on any of the Nano's digital pins. 

 
The ATmega168 and ATmega328 also support I2C (TWI) and SPI communication. The Arduino software 
includes a Wire library to simplify use of the I2C bus; see the documentation for details. To use the SPI 
communication, please see the ATmega168 or ATmega328 datasheet. 

 

 
The Arduino Nano can be programmed with the Arduino software (download). Select "Arduino Diecimila, 
Duemilanove, or Nano w/ ATmega168" or "Arduino Duemilanove or Nano w/ ATmega328" from the Tools > 
Board menu (according to the microcontroller on your board). For details, see the reference and tutorials. 

 
The ATmega168 or ATmega328 on the Arduino Nano comes preburned with a bootloader that allows you to 
upload new code to it without the use of an external hardware programmer. It communicates using the 
original STK500 protocol (reference, C header files). 

 
You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial 
Programming) header; see these instructions for details. 

 

 
Rather then requiring a physical press of the reset button before an upload, the Arduino Nano is designed in 
a way that allows it to be reset by software running on a connected computer. One of the hardware flow 
control lines (DTR) of the FT232RL is connected to the reset line of the ATmega168 or ATmega328 via a 
100 nanofarad capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the 
chip. The Arduino software uses this capability to allow you to upload code by simply pressing the upload 
button in the Arduino environment. This means that the bootloader can have a shorter timeout, as the 
lowering of DTR can be well-coordinated with the start of the upload. 

 
This setup has other implications. When the Nano is connected to either a computer running Mac OS X or 
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or 
so, the bootloader is running on the Nano. While it is programmed to ignore malformed data (i.e. anything 
besides an upload of new code), it will intercept the first few bytes of data sent to the board after a 
connection is opened. If a sketch running on the board receives one-time configuration or other data when it 
first starts, make sure that the software with which it communicates waits a second after opening the 
connection and before sending this data. 

 
 
 
 
 
 
 
 
 
 
 

http://www.ftdichip.com/Drivers/VCP.htm
http://www.arduino.cc/en/Reference/SoftwareSerial
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Main/Software
http://arduino.cc/en/Reference/HomePage
http://arduino.cc/en/Tutorial/HomePage
http://arduino.cc/en/Tutorial/Bootloader
http://www.atmel.com/dyn/resources/prod_documents/doc2525.pdf
http://www.atmel.com/dyn/resources/prod_documents/avr061.zip
http://arduino.cc/en/Hacking/Programmer


 
 

Arduino can sense the environment by receiving input from a variety of sensors and can affect its 
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is 
programmed using the Arduino programming language (based on Wiring) and the Arduino 
development environment (based on Processing). Arduino projects can be stand-alone or they can 
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP). 

 
Arduino is a cross-platoform program. You’ll have to follow different instructions for your personal 
OS. Check on the Arduino site for the latest instructions. http://arduino.cc/en/Guide/HomePage 

 

Once you have downloaded/unzipped the arduino IDE, you’ll need to install the FTDI Drivers to let 
your PC talk to the board. First Plug the Arduino to your PC via USB cable. 

 

 

Now you’re actually ready to “burn” your 
first program on the arduino board. To 
select “blink led”, the physical translation 
of the well known programming “hello 
world”, select 

 
File>Sketchbook> 
Arduino-0017>Examples> 
Digital>Blink 

 

Once you have your skecth you’ll 
see something very close to the 
screenshot on the right. 

 
In Tools>Board select Arduino 
NANO and with the AtMEGA you’re 
using (probably 328) 

 
Now you have to go to 
Tools>SerialPort 
and select the right serial port, the 
one arduino is attached to. 

 

 

 
 
 

http://arduino.cc/en/Reference/HomePage
http://wiring.org.co/
http://www.processing.org/
http://arduino.cc/en/Guide/HomePage
http://arduino.cc/en/Guide/HomePage
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1. Warranties 
 

1.1 The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of 
the sale. The producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including 
improper installation or testing, or for any products that have been altered or modified in any way by a Customer. Moreover, The 
producer shall not be liable for any defects that result from Customer's design, specifications or instructions for such products. Testing 
and other quality control techniques are used to the extent the producer deems necessary. 

 
1.2 If any products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The 
producer's liability shall be limited to products that are determined by the producer not to conform to such warranty. If the producer 
elects to replace such products, the producer shall have a reasonable time to replacements. Replaced products shall be warranted for a 
new full warranty period. 

 

1.3 EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER 
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE 

 
1.4 Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the 
functionality of the products as used in such systems. The producer may provide technical, applications or design advice, quality 
characterization, reliability data or other services. Customer acknowledges and agrees that providing these services shall not expand or 
otherwise alter the producer's warranties, as set forth above, and no additional obligations or liabilities shall arise from the producer 
providing such services. 

 

1.5 The Arduino products are not authorized for use in safety-critical applications where a failure of the product would reasonably 
be expected to cause severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and 

systems, equipment or systems for the operation of nuclear facilities and weapons systems. Arduino products are neither designed 
nor intended for use in military or aerospace applications or environments and for automotive applications or environment. Customer 

acknowledges and agrees that any such use of Arduino products which is solely at the Customer's risk, and that Customer is solely 
responsible for compliance with all legal and regulatory requirements in connection with such use. 

 

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related 

requirements concerning its products and any use of Arduino products in Customer's applications, notwithstanding any applications- 
related information or support that may be provided by the producer. 

 
2. Indemnification 

 

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party 
losses, damages, liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the 
representation and warranties made under this terms and conditions or (ii) the gross negligence or willful misconduct by the Customer. 

 
3. Consequential Damages Waiver 

 

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, 
consequential or exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the 
producer has been advised of the possibility of such damages. This section will survive the termination of the warranty period. 

 
4. Changes to specifications 

 

The producer may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on 
the absence or characteristics of any features or instructions marked "reserved" or "undefined." The producer reserves these for future 
definition and shall have no responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product 
information on the Web Site or Materials is subject to change without notice. Do not finalize a design with this information. 



 
4 cell 16.8V 40A 18650 lithium battery protection board (with recovery function - AUTO Recovery) 

Model: BMS-40A-4S-E / B / S 

Integrated with 10 low internal resistance MOSFETS, continuous discharge 40A, 100mA equalizing current, suitable for electric drills, 

sprayers, LED lights, low power inverters (400W). 
 

BMS-40A-4S-S Standard BMS 4 cell 16.8V 40A lithium battery protection board (with recovery function - AUTO Recovery) 

Starting motor less than 60A / power less than 100W. 

BMS-40A-4S-E Same as above with the difference of Starting motor less than 80A / power less than 135W. 

 
BMS-40A-4S-B Battery balance version, Starting motor less than 80A / power less than 135W. 

 
Application range: Suitable for lithium batteries with a normal voltage of 3.7V and fully charged 4.2V. 

including 1860 to 26650, Polymer lithium batteries. 

PCB Size: -Std & Enh.  55 x 45 x 3.4mm 

"PCB Size: -Balance 60 x 46 x 3.4mm 

Weight: 9.3g and 10.3g 

Charging Voltage: 16.8 ~ 18.1V 

Continues discharge max: 40A 

If heat dissipation environment is not adequate please reduce load 

Continues discharge normal: 40A 

Standard version (-S): Applicable to start electric motor with current below 60A and power up to 100W. 

Enhanced version (-E): Applicable to start electric motor with current below 80A and power up to 135W, with interference function.  

 
Recommended conditions: 

 

 
Shenzhen City, Guangdong Science and Technology Co., Ltd. Address: China's Shenzhen Futian District, Shenzhen Huaqiang North Road 

Copyright © 2010-2015 1688.com All rights reserved. Copyright and Trademark Notices 



 
4S40A : Electric parameter Min Nor Max Unit Notes 

Self consuming current 12 18 24 uA  

Overcharge protection voltage 4.2 4.25 4.3 V  

Balance charging start voltage 4.17 4.12 4.23 V Balanced Version 

Balance current 95 100 105 mA Balanced Version 

Balance charging Power 1.56 1.72 1.91 W Balanced Version 

Over-charge recovery voltage 4.1 4.15 4.2 V  

Over-discharge protection voltage A 2.4 2.5 2.6 V  

Voltage after over discharge protection 2.8 3 3.2 V 1C Discharge 

Voltage after over discharge protection 3.2 3.5 3.8 V 2C Discharge 

Over-discharge recovery voltage 2.9 3.2 3.3 V  

Rds （on） 2.5 3 3.5 mΩ  

Over-current protection current (-S) 54 60 66 A Standard version 

Over-current protection current (-B & -E) 70 80 90 A Balance & Enhanced Version 

Over-current delay time 100 150 200 ms  

Continue work current 0 40 40 A Resistive load 

Continue output power 0 672 672 W Resistive load 

Environment temperature -40 25 85 °C  

 

Trouble shooting: 

Fault phenomenon Fault Checking and Causes Action 

 
Unable to charge 

Measure the voltage of 4 batteries. If the voltage of one group of 

batteries is exceeds about 4.25V, the protection board will start 

overcharge protection. 

Match the batteries well, and don't mix the 

good batteries with the bad ones (normal 

function, no warranty) 

 
Unable to discharge 

Measure the voltage of 4 groups of batteries. If the voltage of one group 

of batteries is less than 2.7V, the protection board will start overcharge 

protection. 

Match the batteries well, and don't mix the 

good batteries with the bad ones (normal 

function, no warranty) 

Charge / discharge failure 0V、4.2V、8.4V、12.6V, 16.8V wrong connection 
Rewire or renew the board 

(Human fault, no warranty) 

Overcharge/over-discharge 

failure 
0V、4.2V、8.4V、12.6V, 16.8V wrong connection 

Rewire or renew the board 

(Human fault, no warranty) 

 

Discharge protection 
Check the battery pack whether has sufficient discharge capacity and 

the starting current of the load whether exceeds the over-current 

protection current of the protective board. 

Replacement of batteries with stronger 

discharge or protective board with larger 

current (beyond working range, no warranty 

Element virtual welding 
There is no connection between one pin of the component and PCB 
welding. 

by return) 

Element continuous welding There is a short circuit between two or more pins of a component. 
Remove components and re-weld 
(Maintainable by return) 

 

Electrostatic breakdown A 
In the absence of electricity, measure the G, D and S pins of MOS 

transistors. If the forward and reverse resistances of any two pins are 
0Ω, it has been damaged. 

Removal and replacement MOSFETs 

transistors 

 
Electrostatic breakdown B 

Remove the MOSFET's transistors and measure the resistance values 

of G and D poles, G and S pins. If there is breakdown, the resistance 

should be infinite under normal conditions. 

Removal and replacement MOSFETs 

transistors 

Note 1: The successful start of the drill requires three 15C-20C power battery, or six 10C-15C power battery (ordinary 18650 cannot start the drill!!). 

Note 2: Strictly according to map wiring 0V, 4.2V, 8.4V, 12.6V, 16.8V, do not deliberately short circuit. 

Note 3: When the load of the brush motor is used, try to connect a non-polar capacitor (withstand voltage above 25V, capacity 10uF-100uF) to the 

motor's positive and negative terminals to prevent the reverse spike from the motor. Break the MOSFET's. 

Note 4: 4 groups of batteries in series, please ensure that the voltage of each group of batteries, if not the same, please fill each battery separately 

and then use in series. 

For battery test, discharge and the voltage that drop faster in a particular battery group there are poor batteries in this group. 

For some of the poor basis of electronic customers to explain: 

Balanced charge is only auxiliary functions, try not to put a good battery and poor battery mixed together! 4 sets of battery capacity / resistance 

closer to the better! (3 good battery +1 Poor battery use effect = 4 poor battery use effect). 

Shenzhen City, Guangdong Science and Technology Co., Ltd. Address: China's Shenzhen Futian District, Shenzhen Huaqiang North Road 

Copyright © 2010-2015 1688.com All rights reserved. Copyright and Trademark Notices 
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Code: SCC-30A-PWM-LCD 

SOLAR CHARGE CONTROLLER SCC-30A-PWM-LCD 
 

 

 

Solar panels are a clean and ecological source of electricity. 

Obtaining this energy, however, poses a number of challenges 

for device designers. The amount of energy produced by the 

panel is strongly dependent on the angle of incidence and the 

intensity of the light falling on the surface of the cells. This, in 

turn, leads to unstable power supply parameters at the output, 

as even shading a small part of the panel may drastically reduce 

the efficiency. 

 
The optimal solution to the above-mentioned problems is the use 

of a set consisting of a solar panel, a battery and a charge 

controller. Such a set allows to ensure constant parameters of 

power supply to receivers, and also to store energy produced 

excessively for later use. 

 

The SCC-30A-PWM-LCD solar charge controller allows you to 

connect panels connected to each other both in series and in 

parallel - remembering not to exceed the permissible values of 

current and voltage at the input of the device. Due to the 

operating characteristics of the PWM controllers, it should be 

remembered that when the panels are connected in series, the 

rated voltage at the output for charging the battery is 24V. 

 

Attention! Solar controllers are adapted to work with solar 

panels. Do not use them with any other power source. 

 

 

 
Regulation Type: PWM 

Rated voltage: 12 / 24 V 

Rated current: 30 A 

 
 

Permitted voltage range: 

• ≤ 23 V for 12 V battery - The range of the highest operating voltage of a set of 

panels connected to one input of the controller 

• ≤ 46 V for 24 V battery - The range of the highest operating voltage of a set of 

panels connected to one input of the controller 

Output voltage: Equal to the voltage at the battery terminals 

Battery charging current: max. 30 A 

Load Current: max. 10 A 

 

 
 
 

Main features: 

• 2 x USB power output : 5 V / 2.5 A, 

• The device is designed to charge only AGM, gel and lead-acid batteries, 

• LCD display, 

• LED diodes indicating the device operation status, 

• Operation modes : 

- 24H - the load is powered all the time 

- 1H ... 23H - the load is powered for the selected number of hours after sunset 

- 0H - the load is powered from dusk till dawn 

Weight: 0.13 kg 

Dimensions: 134 x 70 x 30 mm 
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ESP32 
 

 Periferal pada ESP32 

Sebagaimana pernah dibahas pada tulisan yang lalu, ESP32 memiliki periferal sebagai 
berikut 

 
 18 kanal ADC (Analog-to- Digital Converter) 
 3 antarmuka SPI 
 3 antarmuka UART 
 2 antarmuka I2C 
 16 kanal output PWM 
 2 kanal DAC (Digital to Analog Converter) 
 2 antarmuka I2S 
 10 GPIO sensor kapasitif 

 
Fitur ADC (analog to digital Converter) dan DAC (Digital To Analog Converter) spesifik 
dapat digunakan hanya pada pin -pin tertentu saja. Sedangkan fitur UART, I2C, SPI, 
PWM dapat diaktifkan secara programmatically. Berikut adalah diagram  pin  –  pin  
pada development Board ESP32 

 

 

Meskipun begitu, tidak semua pin dengan fitur tertentu pada ESP32 cocok digunakan 
untuk semua keperluan di dalam project. Tabel berikut menunjukkan pin – pin yang 
paling baik digunakan sebagai input, output dan beberapa catatan yang perlu 
diperhatikan saat menentukan pin mana yang digunakan. 

 

Pin yang diberi highlight hijau, bisa digunakan di dalam project.  Sedangkan  pin  
dengan highlight kuning bisa digunakan namun dengan catatan yang perlu  
diperhatikan, karena terdapat perilaku yang tak terduga terutama saat proses boot. Pin 
dengan highlight merah tidak direkomendasikan sebagai input ataupun output. 



GPIO Input Output Catatan 

0  
pulled up 

 
OK 

 
output sinyal PWM saat boot 

1 TX pin OK output debug saat boot 

2 OK OK Terhubung ke LED on board 

3 OK TX pin HIGH saat boot 

4 OK OK 
 

5 OK OK output sinyal PWM saat boot 

6 x x terhubung dengan SPI Flash terintegrasi 

7 x x terhubung dengan SPI Flash terintegrasi 

8 x x terhubung dengan SPI Flash terintegrasi 

9 x x terhubung dengan SPI Flash terintegrasi 

10 x x terhubung dengan SPI Flash terintegrasi 

11 x x terhubung dengan SPI Flash terintegrasi 

12 OK OK boot gagal ketika mendapatkan input high 

13 OK OK 
 

14 OK OK output sinyal PWM saat boot 

15 OK OK output sinyal PWM saat boot 

16 OK OK 
 

17 OK OK 
 

18 OK OK 
 

19 OK OK 
 

20 OK OK 
 

21 OK OK 
 

22 OK OK 
 

23 OK OK 
 

24 OK OK 
 

 



25 OK OK 
 

26 OK OK 
 

27 OK OK 
 

28 OK OK 
 

29 OK OK 
 

30 OK OK 
 

31 OK OK 
 

32 OK OK 
 

33 OK OK 
 

34 OK OK 
 

35 OK OK 
 

36 OK 
 

Hanya input 

37 OK 
 

Hanya input 

38 OK 
 

Hanya input 

39 OK 
 

Hanya input 

 

 

 Pin Hanya Untuk Input 

GPIO 34 hingga 39 hanyalah dipergunakan sebagai input. Pin – pin tersebut tidak 
memiliki pull up internal atau resistor pull down. Berikut adalah pin – pin tersebut 

 
 GPIO 34 
 GPIO 35 
 GPIO 36 
 GPIO 39 

 
 SPI flash terintegrsi dengan ESP-WROOM-32 

GPIO 6 hingga GPIO 11 dapat diakses oleh beberapa development board ESP32. 
Namun pin – pin tersebut terhubung kepada SPI Flash yang teritegrasi dengan ESP- 
WROOM-32 sehingga tidak direkomendasikan digunakan untuk keperluan lain. Jadi 
jangan gunakan pin – pin berikut 

 
 GPIO 6 (SCK/CLK) 
 GPIO 7 (SDO/SD0) 
 GPIO 8 (SDI/SD1) 
 GPIO 9 (SHD/SD2) 
 GPIO 10 (SWP/SD3) 
 GPIO 11 (CSC/CMD) 



 Capacitive touch GPIO 

ESP32 memiliki 10 sensor sentuh kapasitif yang dapat mengindera benda apapun yang 
menyimpan muatan listrik seperti kulit manusia. Sehingga pin – pin tersebut dapat 
mendeteksi variasi induksi ketika GPIO disentuh dengan jari. Pin ini dapat dengan 
mudah diintegrasikan dengan bantalan kapasitif dan menggantikan tombol mekanik. 

 

Berikut adalah sensor internal sentuh yang terhubung dengan GPIO 

 
 T0 (GPIO 4) 
 T1 (GPIO 0) 
 T2 (GPIO 2) 
 T3 (GPIO 15) 
 T4 (GPIO 13) 
 T5 (GPIO 12) 
 T6 (GPIO 14) 
 T7 (GPIO 27) 
 T8 (GPIO 33) 
 T9 (GPIO 32) 

 
 Analog to Digital Converter (ADC) 

ESP32 memiliki 18 kanal masukan ADC 12 bit, sedangkan ESP8266 hanya 1 kanal 
ADC 10 bit. Berikut adalah GPIO yang dapat dipergunakan sebagai ADC berikut dengan 
kanalnya. 

 
 ADC1_CH0 (GPIO 36) 
 ADC1_CH1 (GPIO 37) 
 ADC1_CH2 (GPIO 38) 
 ADC1_CH3 (GPIO 39) 
 ADC1_CH4 (GPIO 32) 
 ADC1_CH5 (GPIO 33) 
 ADC1_CH6 (GPIO 34) 
 ADC1_CH7 (GPIO 35) 
 ADC2_CH0 (GPIO 4) 
 ADC2_CH1 (GPIO 0) 
 ADC2_CH2 (GPIO 2) 
 ADC2_CH3 (GPIO 15) 
 ADC2_CH4 (GPIO 13) 
 ADC2_CH5 (GPIO 12) 
 ADC2_CH6 (GPIO 14) 
 ADC2_CH7 (GPIO 27) 
 ADC2_CH8 (GPIO 25) 
 ADC2_CH9 (GPIO 26) 

 
 Digital to Analog Converter (DAC) 

Ada 2 kanal DAC 8 bit  pada ESP32 yang berfungsi untuk  mengubah sinyal digital      
ke keluaran tegangan analog. Berikut adalah GPIO dan kanal tersebut 

 
 DAC1 (GPIO25) 
 DAC2 (GPIO26) 

 
 GPIO Real Time Clock 



ESP32 juga dilengkapi dengan GPIO yang diarahkan ke RTC subsistem rendah daya 
yang dapat digunakan ketika ESP32 dalam kondisi deep sleep. GPIO RTC ini dapat 
digunakan untuk membangungkan ESP32 dari kondisi deep sleep ketika co-prosesor 
ULP (Ultra Low Power) sedang berjalan. Berikut adalah GPIO yang dapat digunakan 
sebagai external wake up source 

 
 RTC_GPIO0 (GPIO36) 
 RTC_GPIO3 (GPIO39) 
 RTC_GPIO4 (GPIO34) 
 RTC_GPIO5 (GPIO35) 
 RTC_GPIO6 (GPIO25) 
 RTC_GPIO7 (GPIO26) 
 RTC_GPIO8 (GPIO33) 
 RTC_GPIO9 (GPIO32) 
 RTC_GPIO10 (GPIO4) 
 RTC_GPIO11 (GPIO0) 
 RTC_GPIO12 (GPIO2) 
 RTC_GPIO13 (GPIO15) 
 RTC_GPIO14 (GPIO13) 
 RTC_GPIO15 (GPIO12) 
 RTC_GPIO16 (GPIO14) 
 RTC_GPIO17 (GPIO27) 

 
 PWM 

ESP32 memiliki 16 kanal PWM independen yang dapat dikonfigurasi untuk 
menghasilkan sinyal PWM dengan pengaturan yang berbeda – beda. Semua pin yang 
dapat menjadi keluaran dapat dipergunakan sebagai pin PWM (kecuali GPIO 34 hingga 
39) 

 

Untuk mengatur sinyal PWM, perlu ditentukan terlebih dahulu parameter – parameter 
berikut pada program 

 
 Frekuensi gelombang; 
 Duty cycle; 
 Kanal PWM; 
 GPIO mana yang dipergunakan sebagai keluaran gelombang. 

 
 I2C (Inter-Integrated Circuit) 

Jika pembaca memprogram ESP32 menggunakan Arduini IDE, ada dua 
pin default yang mendukung I2C dan didukung oleh pustaka Wire, yaitu 

 
 GPIO 21 (SDA) 
 GPIO 22 (SCL) 



 SPI (Serial Peripheral Interface) 

Secara default, mapping pin untuk SPI di ESP 32 adalah sebagai berikut : 
 

SPI MOSI MISO CLK CS 

VSPI GPIO 23 GPIO 19 GPIO 18 GPIO 5 

HSPI GPIO 13 GPIO 12 GPIO 14 GPIO 15 

 
 Interrupts 

Semua GPIO pada ESP32 dapat diatur sebagai Interrupt 

 
 Strapping Pins 

ESP32 memiliki 6 pin strapping sebagai berikut 

 
 GPIO 0 
 GPIO 2 
 GPIO 4 
 GPIO 5 
 GPIO 12 
 GPIO 15 

 
Pin – pin tersebut digunakan oleh ESP32 saat mode flashing atau bootloader. Pada 
sebagian besar board development yang memiliki USB/Serial built-in. kondisi state pin 
ini tidak perlu dikuatirkan. Karena board yang akan mengaturnya ke  kondisi  yang 
sesuai saat mode flashing atau boot. 

 

Meskipun begitu, jika terdapat periferal yang terhubung dengan ke-6 pin tersebut. Ada 
kemungkinan, proses flashing akan mengalami masalah. Penyebabnya bisa jadi karena 
periferal yang terhubung dengan pin – pin tersebut  mencegah  ESP32  masuk  ke  
mode flashing atau boot. 

 
 Pin berada pada kondisi HIGH saat Boot 

Beberapa GPIO berubah kondisi statenya menjadi HIGH atau keluaran sinyal PWM saat 
boot atau reset. Ini berarti, akan terdapat keluaran yang tak terduga saat pin – pin GPIO 
berikut berada pada kondisi reset atau boot. 

 
 GPIO 1 
 GPIO 3 
 GPIO 5 
 GPIO 6 s/d GPIO 11 (terhubung dengan ESP32 yang terintegrasi dengan 

memori flash SPI – tidak direkomendasikan untuk digunakan). 
 GPIO 14 
 GPIO 15 



 Enable (EN) 

Pin Enable (EN) adalah pin enable regulator 3.3V yang di-pullup dengan resistor 
sehingga mengetanahkan pin tersebut (menghubungkan ke ground), akan mendisable 
regulator 3.3V. Sehingga pin ini dapat dihubungkan dengan push button misalnya, guna 
merestart ESP32 

 
 Arus Yang Dapat Ditarik Pada GPIO 

Arus maksimal yang dapat ditarik oleh periferal di tiap GPIO adalah 12mA, sebagaimana 
tertulis pada datasheet 
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Ultrasonic Ranging Module HC - SR04 

 
Product features: 

 
Ultrasonic ranging module HC - SR04 provides 2cm - 400cm non-contact 

measurement function, the ranging accuracy can reach to 3mm. The modules 

includes ultrasonic transmitters, receiver and control circuit. The basic principle 

of work: 

(1) Using IO trigger for at least 10us high level signal, 

(2) The Module automatically sends eight 40 kHz and detect whether there is a 

pulse signal back. 

(3) IF the signal back, through high level , time of high output IO duration is 

the time from sending ultrasonic to returning. 

Test distance = (high level time×velocity of sound (340M/S) / 2, 

 
Wire connecting direct as following: 

 
 5V Supply 

 Trigger Pulse Input 

 Echo Pulse Output 

 0V Ground 

 
Electric Parameter 

 
 

Working Voltage DC 5 V 

Working Current 15mA 

Working Frequency 40Hz 

Max Range 4m 

Min Range 2cm 

MeasuringAngle 15 degree 

Trigger Input Signal 10uS TTL pulse 

Echo Output Signal Input TTL lever signal and the range in 

proportion 

Dimension 45*20*15mm 

mailto:services@elecfreaks.com


Vcc Trig Echo GND 

Timing diagram 

 

 

 

 

 

 
 

The Timing diagram is shown below. You only need to supply a short 10uS 

pulse to the trigger input to start the ranging, and then the module will send out 

an 8 cycle burst of ultrasound at 40 kHz and raise its echo. The Echo is a 

distance object that is pulse width and the range in proportion .You can 

calculate the range through the time interval between sending trigger signal and 

receiving echo signal. Formula: uS / 58 = centimeters or uS / 148 =inch; or: the 

range = high level time * velocity (340M/S) / 2; we suggest to use over 60ms 

measurement cycle, in order to prevent trigger signal to the echo signal. 

 



 

 

Attention: 

 
 The module is not suggested to connect directly to electric, if connected 

electric, the GND terminal should be connected the module first, otherwise, 

it will affect the normal work of the module. 

 When tested objects, the range of area is not less than 0.5 square meters 

and the plane requests as smooth as possible, otherwise ,it will affect the 

results of measuring. 
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 Handson Technology  

L298N Dual H-Bridge Motor Driver 
 

This dua l bidirectional motor driver, is based on the very popular L298 Dual H-Bridge Motor Driver 

Integrated Circuit. The circuit will allow you to easily and independently control two motors of up to 2A 

each in both directions.It is ideal for robotic applications and well suited for connection to a microcontroller 

requiring just a couple of control lines per motor. It can also be interfaced  with  simple manual switches, 

TTL logic gates, relays, etc. This board equipped with power LED indicators, on-board +5V regulator and 

protection diodes. 
 

SKU: MDU-1049 
 

Brief Data: 
 

 Input Voltage: 3.2V~40Vdc. 

 Driver: L298N Dual H Bridge DC Motor Driver 

 Power Supply: DC 5 V - 35 V 

 Peak current: 2 Amp 

 Operating current range: 0 ~ 36mA 

 Control signal input voltage range : 

 Low: -0.3V ≤ Vin ≤ 1.5V. 

 High: 2.3V ≤ Vin ≤ Vss. 

 Enable signal input voltage range : 

o Low: -0.3 ≤ Vin ≤ 1.5V (control signal is invalid). 

o High: 2.3V ≤ Vin ≤ Vss (control signal active). 

 Maximum power consumption: 20W (when the temperature T = 75 ℃). 

 Storage temperature: -25 ℃ ~ +130 ℃. 

 On-board +5V regulated Output supply (supply to controller board i.e. Arduino). 

 Size: 3.4cm x 4.3cm x 2.7cm 
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Schematic Diagram: 
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Board Dimension & Pins Function: 
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Connection Examples: 

Controlling 2-DC Motor with +5V Arduino onboard Power Supply: 

Below is the circuit connection use the on-board +5V power supply from Arduino board, and should be done 

without the 5V Enable Jumper on (Active 5V). This connection can drive two 5V DC motors simultaneously. 
 

 

 

 

Sketch Listing: 

Copy and paste the sketch below to Arduino IDE and upload to Arduino Uno/Mega board. 

/*========================================================================== 

// Author : Handson Technology 

// Project : Arduino Uno 

// Description : L298N Motor Driver 

// Source-Code : L298N_Motor.ino 

// Program: Control 2 DC motors using L298N H Bridge Driver 

//========================================================================== 

*/ 

 

// Definitions Arduino pins connected to input H Bridge 

int IN1 = 4; 

int IN2 = 5; 

int IN3 = 6; 

int IN4 = 7; 

 

void setup() 

{ 

// Set the output pins 
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pinMode(IN1, OUTPUT); 

pinMode(IN2, OUTPUT); 

pinMode(IN3, OUTPUT); 

pinMode(IN4, OUTPUT); 

} 

 

void loop() 

{ 

// Rotate the Motor A clockwise 

digitalWrite(IN1, HIGH); 

digitalWrite(IN2, LOW); 

delay(2000); 

// Motor A 

digitalWrite(IN1, HIGH); 

digitalWrite(IN2, HIGH); 

delay(500); 

 

// Rotate the Motor B clockwise 

digitalWrite(IN3, HIGH); 

digitalWrite(IN4, LOW); 

delay(2000); 

// Motor B 

digitalWrite(IN3, HIGH); 

digitalWrite(IN4, HIGH); 

delay(500); 

 

// Rotates the Motor A counter-clockwise 

digitalWrite(IN1, LOW); 

digitalWrite(IN2, HIGH); 

delay(2000); 

// Motor A 

digitalWrite(IN1, HIGH); 

digitalWrite(IN2, HIGH); 

delay(500); 

 

// Rotates the Motor B counter-clockwise 

digitalWrite(IN3, LOW); 

digitalWrite(IN4, HIGH); 

delay(2000); 

// Motor B 

digitalWrite(IN3, HIGH); 

digitalWrite(IN4, HIGH); 

delay(500); 

} 
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Controlling Stepper Motor 

In this example we have a typical NEMA-17 stepper motor with four wires: 
 

 

The key to successful stepper motor control is identifying the wires - that is which one is which. You will need to 

determine the A+, A-, B+ and B- wires. With our example motor these are red, green, yellow and blue. Now let's get 

the wiring done. 
 

 
Connect the A+, A-, B+ and B- wires from the stepper motor to the module connections 1, 2, 13 and 14 
respectively. Place the jumpers included with the L298N module over the pairs at module points 7 and 12. 

Then connect the power supply as required to points 4 (positive) and 5 (negative/GND). 

 

Once again if your stepper motor's power supply is less than 12V, fit the jumper to the module at point 3 
which gives you a neat 5V power supply for your Arduino. 

 

Next, connect L298N module pins IN1, IN2, IN3 and IN4 to Arduino digital pins D8, D9, D10 and D11 

respectively. Finally, connect Arduino GND to point 5 on the module, and Arduino 5V to point 6 if sourcing 

5V from the module. 

 

Controlling the stepper motor from your sketches is very simple, thanks to the Stepper Arduino library 

included with the Arduino IDE as standard. 
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To demonstrate your motor, simply load the “stepper_oneRevolution” sketch that is included with the 

Stepper library, for example: 
 

 

Finally, check the value for 

 
const int stepsPerRevolution = 200; 

 

in the sketch and change the 200 to the number of steps per revolution for your stepper motor, and also the 

speed which is preset to 60 RPM in the following line: 

 
myStepper.setSpeed(60); 

 

Now you can save and upload the sketch, which will send your stepper motor around one revolution, then 

back again. This is achieved with the function 

 
myStepper.step(stepsPerRevolution); // for clockwise 

myStepper.step(-stepsPerRevolution); // for anti-clockwise 

 

Connection for the sketch “stepper_oneRevolution”: 
 

 
Web Resources: 
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LM2596 DC-DC Adjustable PSU Module 
 

LM2596 DC to DC step down regulator, adjustable +1.23 to 35vdc output, 2A. Ideal for battery 

operated projects requiring a regulated powersupply. 
 

 

 
 

Specifications  

Regulator Type: Step Down ( Non Isolated input to Output ) 

Input Voltage: +4 to 40vdc 

Output Voltage: +1.23 to 35vdc 

Output Current: 2A rated, ( 3A maximum with heatsink ) 

Efficiency: Up to 92% ( when output voltage is set high ) 

Switching Frequency: 150kHz 

Dropout Voltage: 2vdc minimum 

Protection: Short circuit current limiting 

Load Regulation: +/- 0.5% 

Voltage Regulation: +/- 2.5% 

Temperature: -40 to +85 deg C ( output power less than 10Watts ) 

Board Size: 43.6mm L x 21mm W x 14mm H 

Data Sheet: National LM2596 

http://www.ti.com/product/lm2596
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Merlin Equipment Limited, Clyst Court, Hill Barton Business Park, Exeter, EX5 1SA United Kingdom 

 
T: +44 (0) 1202 697979 F: +44 (0) 1202 691919 W: www.merlinequipment.com 

 
 

 

Semi-Flexible Solar Panels 

Semi-flexible solar panels with high-efficiency Sunpower 

mono crystalline cells can be curved to a maximum 30 

degree and are widely used in RV, Marine, Caravan and 

applied to all irregular surfaces. 

 

 

Easy Installation 

 Semi-Flexible solar panels can be 

affixed by adhesive or grommets 

(with which you can easily attach or 

detach the panels.) 

 Holes on panels are pre-drilled for 

fast mounting and securing, perfect 

for non-permanent installations. 

Reliability 

 The Junction Box is sealed and 

waterproof 

Flexible and Widely Compatibility 

 Our flexible solar panels can be curved to 

a maximum 30 degree arc. 

 Versatile instillation options; applications 

for RV, Boat, Cabin, Tent, Yachts or any 

irregular surfaces. 

High Efficiency 

 The efficiency of semi flexible solar panel 

is up to 25% 

 

Model Number SLPA050-18 SLPA100-18 SLPA150-18 

Solar Cell Sunpower Solar Cell 

Laminated Way ETFE Lamination 

Number of cells and connec- 
tion 

 
32 cell series 

 
64 cell series 

 
93 cell series 

Test condition 1000W/M² Am1.5 T=25°C R=5.5Ω 

Operating Tempature -10°C TO 80°C 

Error -10% 

Maximum Power(Pm) 50W 100W 150W 

Voltage at max power(Vm) 17.6V 17.6V 26.0V 

Curent at max power(lm) 2.84A 5.68A 5.78A 

Short Circuit Current(lsc) 3.12A 6.25A 9.10A 

Open circuit voltage (Voc) 20.8V 20.8V 21.1V 

Dimension of module 555*535*2.5MM 1065*540*2.5MM 1080*780*2.5MM 

Weight 1.2KG% 1.95KG 2.68KG 

Junction Box/Connector OP65/MC4 0.5M IP65/MC4 0.8M 1P65/MC4 0.8M 
 

Merlin Solar Flexible Panels 

T H E P O W E R P E O P L E 

http://www.merlinequipment.com/


 

Raspberry Pi 3 Model B+ 

 

  Specifications  
 
 

Processor: 

 

Memory: 

Connectivity: 

 
 

 
Access: 

 
Video & sound: 

 
 

 
Multimedia: 

 

SD card support: 

 

Input power: 

 
 

 
Environment: 

Compliance: 

 

Production lifetime: 

Broadcom BCM2837B0, Cortex-A53 

64-bit SoC @ 1.4 GHz 

1GB LPDDR2 SDRAM 

2.4 GHz and 5 GHz IEEE 802.11.b/g/n/ac wireless 

LAN, Bluetooth 4.2, BLE 

Gigabit Ethernet over USB 2.0 (maximum throughput 

300 Mbps) 

4 × USB 2.0 ports 

Extended 40-pin GPIO header 

1 × full size HDMI 

MIPI DSI display port 
MIPI CSI camera port 

4 pole stereo output and composite video port 

H.264, MPEG-4 decode (1080p30); H.264 encode 

(1080p30); OpenGL ES 1.1, 2.0 graphics 

Micro SD format for loading operating system and 

data storage 

 

5 V/2.5 A DC via micro USB connector 

5 V DC via GPIO header 

Power over Ethernet (PoE)–enabled (requires 

separate PoE HAT) 

Operating temperature, 0–50 °C 

For a full list of local and regional product approvals, 

please visit www.raspberrypi.org/products/raspberry - 
pi-3-model-b+ 

 
The Raspberry Pi 3 Model B+ will remain in production 

until at least January 2023. 

 

 

 

 

 

 

 

raspberrypi.org 

 

https://www.raspberrypi.org/products/raspberry-pi-3-model-b%2B/
https://www.raspberrypi.org/products/raspberry-pi-3-model-b%2B/
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Raspberry Pi 3 Model B+ 

 

  Physical specifications  
 
 
 

 

Warnings 

This product should only be connected to an external power supply rated at 5V/2.5 A DC. Any external power 

supply used with the Raspberry Pi 3 Model B+ shall comply with relevant regulations and standards applicable 
in the country of intended use. 

This product should be operated in a well-ventilated environment and, if used inside a case, the case should 

not be covered. 

Whilst in use, this product should be placed on a stable, flat, non-conductive surface and should not be 

contacted by conductive items. 

The connection of incompatible devices to the GPIO connection may affect compliance, result in damage to 

the unit, and invalidate the warranty. 

All peripherals used with this product should comply with relevant standards for the country of use and be 
marked accordingly to ensure that safety and performance requirements are met. These articles include but 

are not limited to keyboards, monitors, and mice when used in conjunction with the Raspberry Pi. 

The cables and connectors of all peripherals used with this product must have adequate insulation so that 

relevant safety requirements are met. 

 

Safety instructions 

To avoid malfunction of or damage to this product, please observe the following: 

Do not expose to water or moisture, or place on a conductive surface whilst in operation.  

Do not expose to heat from any source; the Raspberry Pi 3 Model B+ is designed for reliable operation at 

normal ambient temperatures. 

Take care whilst handling to avoid mechanical or electrical damage to the printed circuit board and connectors.  

Whilst it is powered, avoid handling the printed circuit board, or only handle it by the edges to minimise the 

risk of electrostatic discharge damage. 

 

raspberrypi.org 
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Specifications for WEBCAM-720P 
 

Astrum 720p Hd USB Black Webcam With Mic 
 

 

Astrum 720p Hd USSBlack Webcam With Mic 

 
Astrum 

 
Out of Stock 

 
This product is no longeravailable for purchase. This information is for reference purposes only. 

Click heretobrowsetor similar products and for great alternatives' 

 
Qven,iew: 

 

Full HD webcam that delivers high quality audio and video in MPG/ Y\JV  format.  It  3-axis  clamp fits perfectly to all  devices,  laptops LCD,LED  and  CRT  mo nitor s.  Suppo r ts 

72 0p reso lution (192 0x10 80p) with 30fps outp ut. 

 

Specific atio ns: 
 

@2022 Respective owners and brand holders. This table has been carefully researched and generated by ComXpert International cc(b'Www comx-computers .co.za), 

however, errors and omissions may occur. Only references to South Africa apply. All products are sourced in South Africa from the official suppliers and the warranty is that 

of the local supplier. E&OE This table and our site's content may be used on condition that this notice and link remains intact and unaltered. 

Specifications 

Product Code 

Resolution 

Support 

Mic 

Interface 

ImageFormat 

Color 

Video Formats 

Video Resolutions 

Connectors 

Compatibility 

Camera  

Connectivity  

Mobile Compatibilty 

UseFor 

Grip 

Cable Length 

Sensor 

SupportPhonesize 

Dimensions  

Weight 

Package Contents 

WEBCAM-720P 

Upto 1080P full HD 

Mac OS / Windows / Linux / IOS / Android 

External Microphone 

USS 2.0 

JPG / BMP 

Black/ Red 

MPEG / YUV 

1920 x 1080 at 30fps 

USS Port / Micro USS Cable 

Universal 

720 pixels 

USS 2.0 

IOS and Andro id 

Mult i-Purpose 

Rubb er 

140cm 

CMOS Sensor 

All 

20.0 x 16.5 x 5.2 cm 

191g 

1 HD Webcam 


